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1 Teacher workspace

The Teacher workspace is what you see when you start the Teacher module:

T NetOp Teacher - 60 _ (o[ B ]
Favorites Teach Control Manage Tools Options Help

3 D @ [ W @ ® @

@ Entire Media Default Observe Deny  Allow Chat Record Stog

Screen File = Image Internet Al

T Details View - 60 alpha ~
2 Status Student Display Ma.. ¢  Windows Login Name Computer Name Policy Information
Details Kelly Myrick km HO003 None
e Justin Davies id LAPTOP-XP None |
§a Erica Bryant ebr TABLET Mone

Classroom Peter Jacobsen ol DELL-D430 Mone
o L [%] V003

Thumbnails

Lesson Plan

&

Recordings

Tests
P, \E. 77| i,

Activity Groups
+ |l @

Class Setup m

The workspace has two important components:

e Teacher Ribbon at the top that you use
to do the daily teaching tasks, like for
example to show the students how to do
something, to monitor students to learn
whether they have understood an
assignment, or to give out tests.

e Views buttons to left that you use to
select what you currently want to see
and do within the Teacher module.

The Views buttons

The content in the work area in the middle changes depending on which of the views
button you click.

The views buttons are used in different situations:
e Daily teaching situations: Details View, Classroom View and Lesson Plan View.
e Observing students: Thumbnails View and Activity View.

e Preparing lessons: Recordings View and Tests View - and the planning part of
Lesson Plans View view.

e Setting up the class for different work situations: Class Setup View.
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Each of the views, except for Details View, has a shortcut menu (A shortcut menu
is opened by right-clicking anywhere in the content area) with commands that are
specific to the view. For example, the Classroom View has a shortcut menu that
you can use to change the background bitmap and the Lesson Plan View has a
shortcut menu that you can use to manage the individual items that make up a
lesson plan.

. EF Details View
b

ot _I' Displays all the available information about each computer where the
allzE

Student module has been installed and a student has logged on.
[
£ 2 The Details View view can be customized in that additional
Classronm information can be added for each student:

e On the Options tab, in the Startup group, click General.

- -
F -

Thumbnails Tip

_ In Details View as well as in Classroom View and Thumbnails View,
r_j click the small pie icon to toggle between viewing all students

Lesson Plan | COMputers that are recognized by the Teacher module, and viewing
only student computers that are currently logged on.

-

Classroom View

Recordings

Displays an icon for each of the student computers. The icons can be
arranged to reflect the actual seating plan in the classroom.

Test= . .
Thumbnails View

-

i Displays a small picture for each of the student computer screens; the

Activity picture shows what each student is currently working on.

:. | %/ Lesson Plan View

Cla=z Setup Displays the current lesson plan.

ikl Whatis a lesson plan?

A lesson plan consists of one or more items that the teacher has
planned to do or go through during the lesson. For example, during
a "French as a foreign language" lesson, the teacher might want
to explain about irregular verbs and the five categories they fall
into; next the teacher might want to test the students’
understanding of the concepts, and finally the teacher might want
to discuss the possible test answers with the students.

This might be constructed as a lesson plan with a demonstrate
item, a test item, and a communicate item.

When a lesson plan has been created, the teacher can use the
Lesson Plan View to see the items that make up the particular lesson
and start each item.

See Also
Create a lesson plan
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Recordings View
Displays the recordings that the teacher has previously made.

Recordings can be made from the Recordings View or by clicking
Record on the Teach tab.

Recording may show what happens on the teacher's screen or what
happens on a selected student's screen. A recording can be played on
the teacher and shown to students in a demonstration, or it can be
distributed to students to be played on their local machines.

See Also
Record and distribute recordings

Tests View

Displays the tests and surveys that the teacher has previously made.
If any of the tests or surveys have been used in a class, the results
are displayed on the Results tab.

Tests and surveys are created and managed (edited, renamed,
deleted) from the Tests and Surveys tabs in the Tests View.

Tests can be a number of different types, for example an essay or a
text completion exercise. A survey on the other hand is a list of
questions with one or more answers to each question.

When a test or a survey has been created it can be included as a
component in a lesson plan.

See Also

Question types

Create a test using the Test Wizard
Create a test using the Test Designer
Create a survey

Run a test or a survey

Activity View

Displays the student by display name as well as the applications that
each student is currently running or the Web sites each student is
currently visiting.

Use the shortcut menu to control what the individual student uses, for
example to close or hide an application.

Tip
Click the Start and Stop icons to manage activity control.

See Also
Monitor a student's progress

Class Setup View

Displays icons for all students as well as the groups that the teacher
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has chosen to divide the class into.

The sole purpose of creating groups in this particular sense is to make
selection of student computers easy when activity plans or knowledge
levels make it natural to divide the class into fixed groups. For
example, you may have a group of students who take a test and you
may have another group of students that you want to supervise.
Groups may be deleted and created on-the-fly and students can be
members of several groups.

Use the shortcut menu to mange (create and delete) groups, to add
students to groups, and to activate student computers.

See Also
Using groups

k=l TheTeacherRibbon

The tabs on the Teacher Ribbon at the top of the workspace are grouped according
to teaching tasks. The tabs are enabled when one or more students are selected.
You can customize the Teacher Ribbon to match you teaching methods and
preferences and, for example, make sure that the features you most frequently use
are available on the Favorites tab. For details about how to do this, see Personalize

Favarites Teach Cantrol Manage Toaols Cptions Help
D& = U (@ «a @
Entire Media Default Chserve Deny  Allow Chat Record

Screen  File - Image Internet Al

P P PR f . M -, |

Favorites tab The Favorites tab is a collection the most frequently used

Teach tab

Control tab

teaching commands.

In the majority of everyday teaching scenarios you will likely be
using only the Favorites tab.

Note

The Stop button is also available on the Teach, Control and
Manage tabs; clicking it stops any ongoing session, whether it is a
demonstration, attention or communicate session.

The Teach tab commands are grouped in Demonstrate, Run and
Record. Each of these three groups includes the entire range of
alternatives within an area. For example, the Demonstrate group
includes seven alternatives. The most frequently used alternatives
are also available from the Favorites tab. The general idea is that
you will likely be using the Favorites tab in your daily teaching but
can turn to the Teach tab when you need alternatives.

The Control tab commands are grouped in Attention, Policy and
Supervision. Use one of the Attention alternatives to lock
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Manage tab

Tools tab

Options tab

Tip

student computer screens, keyboards and mouse. Use the Policy
alternatives to apply a policy that defines which programs can be
used or which Internet sites can be accessed. Use the
Supervision alternatives either to view student computers'
screens one at a time, or to remote control student computers. As
with the commands on the Teach tab, select commands from the
Control tab are also available on the Favorites tab.

The Manage tab commands are focused on managing the
classroom in various ways: by setting up workgroups,
communicating with students, distributing and collecting files, and
restarting or shutting down student computers. As with the
commands on the Teach and Control tabs, select commands from
the Manage tab are also available on the Favorites tab.

The Tools tab commands are collections of tools related to class
management, to Teacher module setup, to preparing for working
from home by copying data from the Teacher module, and to
update of Netop School software.

The Options tab commands are grouped in Teach, Control,
Startup, Advanced, Profiles and Themes and are used to set up
how the commands in the Teacher module work. The commands in
the Advanced group are advanced in two senses: they typically
require technical knowledge and they are typically set up once and
then rarely changed. This goes for example for Connection which
is used to set up how the Teacher and Student modules
communicate and for Audio-Video Chat which is used to configure
audio.

Profiles and Themes are predefined layout for tabs and color
scheme selections.

Note

Personalize in the Profiles group is used to customize the
Teacher Ribbon to match your teaching methods and preferences.
The personalize options let you completely define both the layout
of tabs and groups as well as which commands should be available
on each tab and within each group.

The numbers in the lower right part of the Teacher module status bar indicate:

e The total number of student computers that have ever been connected to the Teacher

module.

e The number of connected student computers in the current class.

e The number of selected student computers in the current class.

e The number of available student computers in the Available Students pane in Class

Setup View.
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2 Student workspace

The basic setup of the Student module determines what options you have access to.

There are two basic setup modes:

*IJ*""' O % 13140

Visible mode If the Netop Student module runs in visible mode, you
have access to all features in the module. The window
may occasionally appear minimized and be represented
with an icon in the notification area.

Hidden mode If Netop Student module runs in hidden or stealth
mode, only one option is available: double-click the life
belt icon to request help from the teacher.

k= Overview of menus

File

View

Action

Tools

Click Exit to close down the Student module.
Click Toolbar to toggle displaying the student buttons.

Most of the commands on the Action menu are identical to the
commands available by clicking the student buttons:
e Join, leave, and rejoin a class.

e Request help from the teacher and cancel a help request that has
already been sent.

e End session to stop the current remote control session.

Options - Define options for all Student module features.
Protection Password - Define password protection settings.

Check for New Updates - Connect to an update server and search for
software updates for Student module. Update settings are defined
from the Web Update options dialog box.

Run Setup Wizard - Start the setup wizard. The setup wizard has been
run at least once to set up the Student module but can be run again
at any time to modify settings.
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k= Overview of student buttons

Join Class

Leave Class

Rejoin Class

Request help

Cancel help

If joining a specified class has not been predefined as part of the
Student module setup options, click the Join Class button to request
to join a class.

Disconnect from the class you are currently in.

If you have been signed in to a class and accidentally left it or have
been disconnected, click Rejoin Class to enter it again.

Request help from the teacher. Your request will display on the
teacher’'s computer.

If you resolve your problem before the teacher has had an
opportunity to get back to you, click the Cancel Help button.
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3 Daily teacher tasks

3.1 Demonstrate to a student

Demonstrating is a widely used teaching method and Netop School offers a number of
ways to demonstrate: by showing what you are doing on your desktop, by showing
movies or by showing a recording of how some task is done.

k=l Tip: To allow student to interrupt during a demonstration
1.0n the Options tab, in the Teach group, click Demonstrate.

2.Under On Receiving Students, select the Launch Toolbox check box.

k=l Demonstrate by showing all activity on your desktop
1. Select one or more student computers.
2.0n the Favorites tab, in the Demonstrate group, click Entire Screen.

All activity on your desktop will be displayed on the selected student computers and
the student computers' keyboard and mouse are locked. You can choose to set up
student computers to be allowed to interrupt during demonstrations.

To end the demonstration, click the End Session button on the Screen Control
panel.

k=l Demonstrate by showing a movie

A movie can be a good and efficient way to supplement other teaching methods.
Videos are broadcast simultaneously to all student computers, and the replay
function is controlled from the teacher’s computer. Films can be paused at any time,
and student computers can be locked.

1.Select one or more student computers.

2.0n the Favorites tab, in the Demonstrate group, click Media file and then
click Browse to locate the media file you want to show.

The file called movie which is readily available in the list of media files is a sample
demonstration movie.

When the preparation is complete, the movie is ready for playback on the student
computers and a toolbox with play control buttons is displayed on the Teacher
screen.

3. Click the Play button to run the movie and the End Session to stop the movie
demonstration session.

Note

If the movie file you want to show is substantial in size, you might improve
performance dramatically by placing the file on a shared network drive and run the
demonstration from there rather than copying the file to student computers.

To play a movie from a shared network drive, you must specify specify the entire
path using \\ and without using any drive mappings, for example:

\\server\share\teachershare\largemoviefile.mpg

11
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Note that a video can be created using the Netop Screen Video Tool. For more
information, see Netop Screen Video.

k=l Demonstrate by showing a recording

A demonstration can also consist in showing the students how to do a certain task;
a simple example could be: "How to change the default font in Word". You can record
how to do this and then show the recording on the student computers.

1. Prepare what you are going to record and rehearse it.

2.0n the Favorites tab, in the Record group, click Record to record the activity
on your screen.

For more information about recording, see Record and distribute recordings.

3.To end the session, click the End Session button on the recording control panel
and save the recording.

The recording is complete. And you are ready to assist your students by showing
them the recording.

4.0n the Teach tab, in the Demonstrate group, click Recording and then click the
name of the recording.

The recording now displays on the selected student computers.

See Also
What students can see and do during a demonstration

3.2 What students can see and do during a demonstration

By default, keyboard and mouse are both locked on a student's computer when you do a
demonstration, regardless of the demonstration method you use.

Depending on the situation, you may want to allow students to interrupt a demonstration.
You set this option from the Options tab:

1.0n the Options tab, in the Teach group, click Demonstrate.
2.Under On Receiving Students, select the Launch Toolbox check box.

When this option is selected, students see a small control panel during a demonstration:
=

Using the control panel buttons the students can:

e Request the microphone. Note that the button is only active during an audio chat
session.

e Ask for help by sending a help request to the teacher; see Assist a student for
information about how to handle a help request.

e Request control of their mouse and keyboard so that they run the the present
demonstration. You will be notified that a student has requested to temporarily have
mouse and keyboard unlocked in the teacher control panel.

Whether the students have a control panel or not, you can also choose to temporarily
give a student control of mouse and keyboard:
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e On the teacher control panel, click the Pass the Chalk to Student button and select
the student who should have control.

Tip
Press the Ctrl key on the Teacher computer to suppress any input from Student computer
keyboards and mouse.

3.3 Demonstrate toolbox

When you have started a demonstration session by choosing one of the seven
demonstrate (The demonstrate options are: Entire Screen, Selected Screen Area, Media
File, Media File on the Web, Recording, Specific Monitor, Student Screen) options on the
Teach tab, the Teacher module environment disappears from your screen. Instead a small
toolbox with relevant commands opens to enable you to control the session. The toolbox
commands differ slightly depending on the session type but the left-most button can
always be used to end the session.

Below is an example of the toolbox that is available when you have clicked Entire Screen

Screen Control - <Teacher>

L As /] =

All buttons have a tooltip that explains what the specific command does.

k=l Description of commands

Command Description
End Session Close the toolbox and end the demonstrate session.

Toggle full screen/window  Switch between showing the student screen in full
on Teacher screen mode and in window mode on the teacher
computer.

This command is available only when a student screen
is used for the demonstration. The startup mode for a
Student Screen demonstration is defined from the
Options tab:

1.0n the Options tab, in the Teach group, click
Demonstrate.

2.Select or clear the Hide Teacher Main Window
and Show demo in fullscreen at Startup check
box.

Start/stop Speak Click to start or stop transfer of microphone input and
any application sound from the computer being
demonstrated to the computers on the receiving end.

Tip

If sound transfer does not work, review the sound

13
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Command

Start/Stop Audio-Video
Chat

Start/Stop Netop Marker
Utility

Toggle full screen/window
on Student

Pass the Chalk to Student

Description

recording setup in Windows (Depending on your
computer setup you open the volume control from the
notification area and on the Options menu click
Properties. Click the Recording option to see recording
volume controls). Netop School expects to find a
sound recording device named Wave Out Mix or
Stereo Mix. If this is not available on both teacher
and student computers, add this section to the netop.
ini file:

[AUDIO]

Sound_Mix=<Recording sound mix name>

If the computer sound device does not support
recording sound mix, sound transfer will not work.

Sound transfer and audio-video chat cannot run at
the same time.

Click to start or stop an audio-video chat session with
the student computers that take part in the
demonstrate session.

Click to start or stop Netop Marker Utility that you
can use to mark or magnify an area on the
demonstrated screen.

Switch between showing the teacher computer's
screen in full screen mode and in window mode on the
student computers.

The startup mode is defined from the Options tab:

1.0n the Options tab, in the Teach group, click
Demonstrate.

2.Select or clear the Show demo in full screen at
Startup check box.

Click to hand over control of keyboard and mouse to
the selected student computer. The student can move
the mouse pointer and use the keyboard exactly as if
the student were sitting in front of the teacher
computer.

The student can pass back control or the teacher can
click to get the control back.

3.4 Take control of a student computer

Occasionally it may be useful to be able to lock the screen, the keyboard and the mouse
on selected student computers. The easiest way to do this is to:
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1.Select the student computers to lock.

2.0n the Control tab, in the Attention group, click DefaultImage.

The student computer screens now display the default bitmap included in Netop School.
Unlock student computers by clicking the Default Image button again.

Other display alternatives for the student computer screens are available, though. When
you lock a screen, you can decide what to display on the screen while locked. You can
choose to display:

e An image file of your own choice.

¢ A short text message, for example: "The test is tomorrow morning at 8 A.M."
¢ A longer text message in the form of a text file.

¢ A Web site.

Tip

You can always use the Stop button to release any control of student computers,
regardless of the display alternative you used to lock the student computers.

k=l Overview of different display options on locked student screens

The Attention group on the Control tab has five different display options:

Option Description

Default Display the default bitmap included in Netop School.
Image

Image File Display a bitmap on all student computers.

Note: The bitmap file must be in the same location on all computers.

k= Tip: how to distribute a file

Use Distribute Files or File Manager on the Files menu to
copy a bitmap to the same location on all student computers.

Consider creating a folder on all student computers called
"Student files" or something similar.

Text Display a text on all student computers.
To type a text to display:
1.0n the Options tab, in the Control group, click Attention.
2.Under Show attention, click Text and set the appropriate
options.
Text File Display a text file on all student computers.

Note: The text file can have a maximum length of 255 characters.
Additional characters are ignhored.
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To type a text to display:
1.0n the Options tab, in the Control group, click Attention.
2.Under Show attention, click Text File and set the appropriate
options.
Web Display a Web page on all student computers.

Note: The Web page displays with no address bar and students are
not able to interact with the Web page; they can view only.

To select a Web page to display:
1.0n the Options tab, in the Control group, click Attention.

2.Under Show attention, click Web Page and set the appropriate
options.

3.5 Communicate with a student

Depending on your needs and on the technology available, Netop School offers a number
of ways in which you can communicate with a student:

k=l Send a message
1. Select the student you want to send a message to.
2.0n the Manage tab, in Communicate group, click Send Message.
3.Type the text you want to send and click Send.

The message displays on the student computer. The student cannot reply or send
new a message. If you want the student to reply, use one of the chat options.

k=l Chat with a student
1.Select the student you want to chat with.
2.0n the Favorites tab, in Communicate group, click Chat.
3.In the chat dialog box, type your message and click Send.

The student can reply and the chat session remains open until you close it by
clicking End chat.

k=l Chat with a student using sound and video
1. Select the student you want to chat with.
2.0n the Manage tab, in Communicate group, click Audio-Video chat.

Depending on the hardware available, you can now use your microphone to talk to
the student and if Video has been enabled, you can see each other in the right-hand
side of the dialog box.
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3.6 Send and collect assignments

You can use the Teacher module to distribute assignments and other types of documents
to students. And when the students have completed their assignment, you can collect
the assignment from the Teacher module as well.

Before you start sending and collecting assignments, it is a good idea to create a folder
on each student computer for new assignments and a folder for completed assignments,
forexample:

C:\New assignments - this is where you will place new assignments for students to pick

up.

C:\Completed assignments - this is where student will place completed assignments for
you to pick up.

k=l Send an assignment

1.

2.

3.
4,

On the Manage tab, in the Files group, click Distribute.

The default setting is that the Distribute Files Wizard opens to lead you step-
by-step through the send process. If you do not want to use a wizard to
distribute files, click the Advanced button in the second wizard dialog to open a
dialog box where you can make all three selections. To go back to the wizard,
click the Wizard button in the Distribute files to Students dialog box.

In the first wizard step, click Add files to locate the file or files you want to
distribute.

In the second wizard step, select the students or groups to receive the file.

In the third wizard step, select where the file should be placed on the student
computers and click Distribute.

The file will be placed in the same location on all student computers and this is
where it is useful to have a folder created beforehand.

If you choose not to use the wizard, you make all selections in one dialog box; and
you get the added option of being able to created a destination folder as part of the
process.

k=l Collect an assighment

1.

On the Manage tab, in the Files group, click Collect.

The default setting is that the Collect Files Wizard opens to lead you step-by-
step through the collect process. If you do not want to use a wizard to distribute
files, click the Advanced button in the second wizard dialog to open a dialog box
where you can make all three selections. To go back to the wizard, click the
Wizard button in the Collect files from Students dialog box.

.In the first wizard step, click Specify files to locate the file or files you want to

collect.

Note that you can choose to delete the file or files on the student computers
once you have collected them. This is useful because the students will then be
aware that you have collected the files and they can no longer make any updates.

.In the second wizard step, select the students or groups that you want to collect

files from.
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4.1In the third wizard step, select where the file should be placed on the your
computer and click Collect.

Like with the distribute process: if you choose not to use the wizard, you make all
selections in one dialog box.

Tip: Distribute files directly from Windows Explorer

Files can be moved directly from Windows Explorer to the selected students in the
Teacher interface using a drag-and-drop operation. This opens the Distribute files to
Students window to allow you to decide the destination for the files.

If this is your favorite method and you always use the same destination, selecting the
Use this destination when files are dropped and don't prompt with this dialog check
box will distribute files directly to the selected destination and skip opening the window.

3.7 Run a test or a survey

Test and surveys share a number of characteristics in Netop School and are started and
managed in similar ways. The difference between the two is that a test can have
questions of 10 different types whereas a survey is always multiple choice. The
description below covers both tests and surveys.

k=l Start a test or a survey

¢ In Tests view, select the relevant test or survey and drag it to the group that you
want to take the text or survey.

The test or survey starts on the student computers.
Alternative ways to start a test or a survey

In addition to starting tests or surveys from Tests view, a test or a survey can also
be started in different ways from Details view.

1.In the Details view, select a student or a groups of student.

2.0n the Teach tab, in the Run group, click Run Test and then click the relevant
test in the submenu.

Or on a single student:

e In the Details view, right-click a student, point to Run a Test on this Student
and click relevant test in the submenu.

k=l While the test or survey is running...

Once a test or a survey is running, the Netop School Test Monitor automatically starts
to allow the teacher monitor student progress: Are they having trouble, showing slow
progress, experiencing computer problems?

The Test Monitor compares the students’ answers with the correct answer, as given by
the teacher while creating the questions. If the questions were prepared with scores
these are also continuously and shown in the Test Monitor:

Not viewed
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' Viewed - not answered
@ In progress
@ Answered correctly

:t! Answered incorrectly

Double-clicking a student record will allow you to observe the student computer’s
screen. From there you are also able to take over control of the student.

&, NetOp School Test Monitor

' " . |Samp|e hest Y|

Test Hame Sample test
Score Possible 0

Passing Score [

Student Progress Score Passed
Heidi v @ o ¢ ¢ ¢ 0 Mo
|—| Fllng D'J D'J Ele L) @ L) L) L) L L I:I ND
Katl Heinz ) “@ ¢ @ ¢ ”%E ¢ ¢ ¢ ¢ 0 Ma

Use the three Test Monitor control buttons to Start, Pause or Stop the current test

The drop-down list next to the control buttons is useful when you have several
simultaneous tests running. Having different tests running at the same time might be
useful if you wanted to give the students in a class differentiated tests.

When the test or survey completes

When the students have completed a test or a survey, a test report opens
summarizing the students' results.

You can print a class summary and a student summary:

e On the Test Report File menu, click Print Class Summary or PrintUser
Summary.

If you prefer to process the test results in another application, for example in
Microsoft Office Excel, you can export the test result to a comma-separated values
file (.csv), to a Tab-separated file (.tab), or to a file in Excel format (.xls). You can
export from the Test Report File menu, or from the Results tab in Tests View:

¢ On the Test Report File menu, point to Export to and then click CSV file, TAB
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file or XLS file.
- OR -

¢ In Tests View, on the Results tab, right-click a results file and on the shortcut
menu click Export to CSV file, Export to TAB file or Export to XLS file.

3.8 Assist a student

Netop School offers different ways in which the teacher can assist a student, for example
by:

¢ Giving a demonstration, for example by showing all activity on your desktop.
e Starting a chat, with or without video.

e Sending a message.

The teacher can offer assistance at any time.

Assistance can also be as a response to a student request: the student can send a help
request that will appear in the teacher's details view. In case the Netop Teacher module
is not currently on top, a small life belt icon is also shown in the notification area on the
teacher's computer.

Respond to request for assistance
To respond to the student's request for assistance the teacher can:

e Right-click the student in the Details view, and click the appropriate command.

Depending on the nature of the student's request, the most suitable command could be
Remote Control this student, Chat with this student, Audio-Video Chat with this
student, or Send Message to this student.

When the student has been given required assistance, right-click and choose Clear Help
Request to remove the request and the icon in the notification area.

See Also

Demonstrate to a student
Communicate with a student

3.9 Supervise a student's progress

Netop School offers different ways in which the teacher can supervise a student's
progress, for example by:

k=l Observing which applications and Web sites the students in the class are using

1.Click the Activity button to switch to Activity View.

2.Click the Start Activity Control button to see which applications and Web sites
the students in the class are using.

Tip
Only applications that have active windows on the desktop are listed. Click Task
manager on the Activity View menu to see all running applications.
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The top half of the Activity View lists all active student computers, which
applications and websites they are running and which one is currently active. Two
tabs offer a choice for viewing applications or Web sites. Use the shortcut menu
(Right-click to open a shortcut menu) to temporarily hide an application on a student
computer or to close an unwanted application.

The lower half of the Activity View lists all the different active applications and, if
the Internet is used, which sites are active. If more students are using the same
program (same version and same OS-platform) only one icon will be listed but the
number of students appears beside it as well as the names of the users. Where the
top half of the Activity View includes options to deal with individual student
computers, the lower half, Active Applications and Sites, lets you control which
applications are allowed to run on all the student computers connected to the class

Observing activity of individual students, one at a time.

¢ On the Favorites tab, in the Supervision group, click Observe Students.

This will display the screen of a student computer; the display will automatically
change to that of the next student. In this way you can browse through and see
what each student is engaged in.

Set the time period in which you see each student computer screen from the
Options tab: in the Control group, click Supervision.

While browsing through student computer displays, a control panel is available to let
you for example end the session, scroll to the next student, switch to full screen
display, or take screen shot of the student computer screen.

Observing activity for the whole class by a thumbnail view of all student
computers.

e Click the Thumbnails button to switch to Thumbnails View.

The thumbnail view gives an overview of all student activity that makes it easy to
see if a student is working on a wrong page or is not making any progress.

To follow a student more closely, double-click the student thumbnail. This will open
the student desktop on the teacher screen and enable you to remote control the
student computer.

Using remote control to take over a student’'s computer

Using remote control to take over a student's computer means that you can work on
the student computer as if you were sitting in front of it.

You can start remote control in several different ways, for example:

¢ In Thumbnails View, double-click the thumbnail for the student computer that
you want to control.

OR

¢ In Details View, click the Control tab and then click Remote Control in the
Supervise group.

By default the student computer and the teacher computer share the keyboard and
mouse control. To block the student from using the keyboard and the mouse, click
the Lock Keyboard and Mouse button on the toolbar.
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The toolbar offers a number of other options, for example to restart the student
computer, to copy the clipboard from the student computer or to do a print screen of
the student computer.

Tip
Remote control is a one-to-one session between you and one student computer.

However, you can start several remote control sessions one at a time and run them
in parallel.

3.10 Create and run a lesson plan

As the term implies, a lesson plan is a plan for the contents of a specific lesson. A lesson
plan consists in one or more tasks that the teacher has planned for the class taking the
lesson; these tasks are called lesson actions.

Note that an item to be added as a lesson action must exist before it can be added to a
lesson plan. For example, if a test is to be one of the lesson actions, the test must be
created in Tests View before it can be added as a lesson action.

Tip

A lesson plan is typically created when you are offline, for example when you have
exported module and data and are preparing for a class at home. To be able to select
which students or groups that should be involved in the lesson plan, student information
must be saved when the class is offline. This is automatically done if the option Save
new students between classes is set. To verify that Save new students between
classes has been selected:

e On the Options tab, in the Startup group, click General.

Creating a lesson plan consists in two steps: creating the lesson plan and adding one or
more lesson actions to the lesson plan.

k=l Create a lesson plan
1.Click the Lesson Plan button to open Lesson Plan View.

2.0n the Lesson Plan View toolbar, click the down arrow button to open a menu and click
New.

Lesson Plan View - My Class +Y2Tx] O
3. Type a suitable name for the new lesson plan and click OK.

You have now created a lesson plan and the next step is to add one or more teaching
actions.

k=l Add alesson action to a lesson plan
1.In Lesson Plan View, select the lesson plan you want to add an action to.
2. Right-click the lesson plan window and click Add.

3.In the Lesson Action dialog box, select the action you want to use and set the
options relevant to that action and select the group who should be involved in the
action. Also, type a name and a description.

Note that the actions are identical to the ones available on the Teacher buttons.
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Including an action in a lesson plan simply means that you can execute the
actions in a pre-defined sequence. A typical sequence of lesson actions could be:

1. Demonstrate - the teacher shows how something works or is done to the
students.

2.Run test - the teacher gives the students a test to verify that they have
understood the concepts.

3. Communicate - the teacher chats with the students to discuss the outcome of
the test and the next steps.

Tips
e When you add one of the alternatives from the Attention group as a lesson action,

it might be a good idea to add Stop as the lesson action following the Attention
lesson action.

e Some commands, like for example Log Off or Shut Down, make sense only as the
last lesson action in a lesson plan.

Manage lesson plans

e To create, copy or delete a lesson plan, click the down arrow button to open a
menu and click Manage lesson plans.

When you copy a lesson plan, the copy includes all teaching actions from the
original. Right-click and then click Edit in the Lesson Plan View to modify each
action.

Run a lesson plan

1.In Lesson Plan View, select the lesson plan you want to use.

2.Right-click the first action and click Execute.

Alternatives are to:

e Double-click the action.

e Click the Execute next lesson action button in the Lesson Plan View toolbar.

When a lesson action has been run, a green check mark is automatically added next
to it. To run a lesson action again, right-click it and click Mark as undone.

3.11 Record and distribute recordings

A recording is an alternative to a demonstration: where a demonstration is live and in real
time, a recording is a prepared sequence of steps or actions that the teacher prepares for
the students to view on their computers.

k=l Create a recording

1.0n the Favorites tab, in the Record group, click Record.

The recorder starts immediately and all actions on your desktop are now recorded.
The recorder control panel automatically displays; use it to pause during the
recording if needed.

2.Go through the steps that you want to record and click the Stop recording
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button to end the recording session.
3. Type suitable name for the recording and click OK to save.

All recordings are available from the Recordings View.

k=l Distribute recordings to students

The simple way to distribute recordings is to use a drag-and-drop operation from the
Recordings View:

e Select the relevant recording and drop it to the All group, or to any other group.

The moment you drop the recording to a group, it becomes available to all students
in that group.

Tips
e Send the students in the group a message telling them to open the recording: On
the Manage tab, in the Communicate group, click Send Message.

e The recoding files can also be located outside the School environment. Depending
on the operating system you use, the default folder could for example be:
C:\Documents and Settings\<user>\Application Data\Danware Data\Netop School
\Teacher\Screcord

See Also

Netop Screen Image
Netop Screen Video
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4 Managing the classroom

4.1 Set up how to manage a class

A class is the framework in which a lesson or a test takes place. When the Teacher
module is running, one class is always the active, current one. You can define whether
the Teacher module should start with the same class as the active one by default, or
whether you want to choose which class should be the current one when you start the
Teacher module:

1.0n the Options tab, in the Startup group, click Class.

2.Select the Always Select Class at Startup check box to have the Teacher module
open a list of available classes on startup.

Whether you prefer this setting or the default setting likely depends on the number of
classes you have defined in Netop School.

Options for students joining a class

You can also set up options for student computers joining the class:

1.0n the Options tab, in the Startup group, click Class.

2.Select the Notify when Students join late check box to receive a message in the
notification area when a student computer joins a class which is already in progress.

When a demonstration, a observe session or a chat is taking place, you may or may not
want to allow student computers to join:

e In the Autojoin list select not to allow student computers to join, to have student
computers join automatically, or to be prompted when a student computer joins.

When student computers join, you can choose to limit what they can do initially:
In the Startup Policy list, select one of the extreme policies - Deny All or Allow All - or
a policy you have defined.

See Also
Create a policy

4.2 Invite a student to join a class

How a student computer should behave with respect to joining a class is defined on each
student computer; typically all student computers have identical setup, though.

These are the ways a student computer can behave when starting up:
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Connect to a The student computer automatically connects to a named class

class when starting up. This is the default setting.

Browse for The Browse for classes, Select a class and Use Class Server

classes options leave it up to the student computer to choose a class to
join.

The browse and select options are for joining classes in progress
while the Class Server (Class Server is an advanced module that is
part of the NetOp Class Management package. For additional
information, see http://www.netop.com/netop-389.htm) option can
also be used to join upcoming classes.

Select a class
Use Class Server

Be available for This option leaves it up to the teacher to ask student computers to
any class join a class.

The student computer is available on the network and the teacher
can invite such student computers to join a class.

Tip
On the teacher computer, verify this setting on the Options tab: in
the Startup group, click General.

The check box Get available students should be selected to have
available students shown in the Available Students list in Class
Setup View.

Invite an available student

1.In Class Setup View, right-click a student computer in the Available Students (An
available student is a student who does not automatically join a class) list or invite all
by clicking the small Invite available students button.

2.In the Invite Students dialog box, type an invitation text and click OK to send the
invitation.

When the invitation displays on the student computer, the student can accept or
decline.

4.3 Move a student to another class
If a student has joined the wrong class, you can move the student to another class.

1.In Classroom View, right-click the student you want to move and click Move this
Student to another class.

2.In the Move Student to Class dialog box, select the name of the relevant class and
click Move.

You can also move a student to another class without necessarily switching to
Classroom View:

e Select the student computer you want to move and on the Manage tab, in the
Commands group, click Move.
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Note

Moving a student from one class to another using the class name requires the two classes
to be located on the same subnet. If you need to move the student computer to a class
which is on a different computer or on a different subnet, you must select the TeacherIP
address or DNS name option and type this information. The available classes will be
detected automatically.

4.4 Using groups

Groups are a way to split up students in a class, for example according to projects
students are currently working on. When students are in a group, they are managed as an
entity and it is easy to run a test, do a demonstration or send a message to all students
in the group.

Use Class Setup View to see which students belong to which groups, to create groups
and to add students to groups.

k=l Create a group
There are several ways to create a group:
From Class Setup View:

1. Right-click anywhere in the top pane and on the shortcut menu, point to New
and click Create group.

2.In the New Folder dialog box, type a name for the new group.

From Details View, Classroom View or Thumbnails View:

1. Right-click anywhere in the Groups pane and on the shortcut menu click Create
group.

2.In the New Folder dialog box, type a name for the new group.

Note
Groups are available only within the class where they were created.

k=l Add students to a group
There are several ways to add a student to a group:
From Class Setup View:

1. Right-click the group that you want to add students to and then click Add
student to group.

2.In the Student List dialog box, select one or more student and click OK to add
them.

From the Details View:
e Drag students into the group.

k=l Delete a student from a group
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¢ In Class Setup View, right-click the student and click Delete.

4.5 Add a teacher

1.0n the Options tab, in the Advanced group, click Teachers.
2.Select the Use Teacher Profiles check box.
3.Click Add User and type a user name and a teacher name.

The User name is your identification in the system while Teacher name is used to
identify you during a chat session.

Individual settings like folder choice, groups and bitmaps are saved to the profile. You can
create as many teacher profiles as you need in the Teacher module.

Note

Once you have defined the first teacher profile, you need to log on with that profile to
create the following profiles.

4.6 Teacher profiles: what they are and why to use them

When you use your own user name and password to log on to Windows, your personalized
Netop School settings are automatically saved under your Windows user profile (This
could for example be: C:\Documents and Settings\<initials>\Application Data\Danware
Data\NetOpSchool\Teacher). These settings include startup options like for example class
name and startup policy as well as display settings like for example theme and tab names.

If the computer environment where Netop School is installed has not been set up with
individual Windows users but with one account that all teachers use, Netop School
settings are saved under that one user profile. This means that all users must use the
same settings - unless teacher profiles are used.

Teacher profiles are settings for each individual user of a Teacher module, including
authentication by user name and password.

User name and password may be set up to be identical to the user name and password
used to log on to Windows. In cases when all users log on to Windows using identical
name and password, choosing Windows authentication to log on to Netop School should
not be selected. For a description of the relevant selections when creating teacher
profiles, see Teacher options.

When a user name and a password has been defined in Netop School, the user is
prompted for name and password when starting the Teacher module.

In addition to being able to specify user name and password for one or more user, defining
teacher profiles has other advantages: user settings like folders, groups, tests, and
bitmaps are automatically saved regularly.

Note

Once you have defined the first teacher profile, you need to log on with that profile to
create the following profiles.
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Other differences when teacher profiles have been defined

e You can log off from the Teacher module using the Change Teacher command on the
Tools tab. This command is available only when teacher profiles are used.

e Typically, the name of the current class is shown in title bar. However, if teacher
profiles are used, the teacher profile user name is shown in the title bar instead of the
class name.

4.7 Ask a student to be an assistant teacher

When you are creating a workgroup, you can appoint a student to head the workgroup
and function as a group leader. You can create more workgroups at the same time.

1. From Details View, select the student computers that should be part of the
workgroup.

2.0n the Manage tab, in the Workgroup group, click Workgroup.

3.In the Create Workgroup Session dialog box, select a student to head the
workgroup and click OK.

The selected student computer functions as a teacher computer and has the same
features and functions as the main teacher - unless restrictions have been defined by the
main teacher. On the student computer that functions as a teacher computer, the
Student module minimizes and appears only as an icon in the notification area, and the
Teacher module opens.

The students in the workgroup are temporarily disconnected from the main teacher's class
and join the Assistant Teacher's session.

Information about Assistant Teachers and workgroup members can be seen in the student
views (The student views are: Details, Classroom and Thumbnails): Assistant Teachers
are displayed as connected with workgroup name; workgroup members are displayed as
disconnected but with workgroup name.

End a workgroup session

To end the workgroup session and release the student from being an assistant teacher:

¢ In one of the three student views, right-click a student computer in the workgroup
session and then click Stop Workgroup Session.

The student computers now reconnect to the main teacher's class.

4.8 Unhide the Student module

If a student computer has been set up to run in Stealth mode and you need to change
this, start a remote control session.

1. Select the student computer in question.
2.0n the Control tab, in the Supervision group, click Remote Control.

3.0n the remote controlled student computer, find the executable file: C:\Program Files
\Danware Data\Netop SchooA\STUDENT\Showhost.exe

4. Double-click Showhost.exe and the Student module will be restored to normal mode.

5.0n the student computer, run the Student Setup Wizard and make the necessary
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changes.

4.9 Create a new student account

Typically student computers are set up to join a class when they start up. Alternatively
they can be set up to be available for any class and be listed as such on the teacher
computer. When either of these options are set, student computer accounts are
automatically created.

When student computers do not automatically join, you can manually create a user
account from Class Setup View:

1. Right-click anywhere in the Class Setup View area and on the shortcut menu point
to New and then click Create Student.

2.As a minimum, type Student Login Name and Computer Name or Windows Login
Name.

Student Login Name is required because when a student computer connects, it will be
identified as an existing account only if the Student Login Name matches that of an
existing account.

Other ways to create a new student account

¢ On the Options tab, in the Startup group, click General, and select the Save new
students between classes check box. When student computers join a class, the
student computer information is saved.

e Copy student computers from the Available Students pane, or use a drag-and-drop
operation to move student computers from the Available Students pane.

4.10 Student options to prevent teacher control

When the Student module is running in hormal mode so that students have access to
commands and options in the Student module, student also have access to limiting what
the teacher can do in the Teacher module with respect for example to locking student
computers, supervising, distributing and collecting files, and defining access to the
Internet and to the use of programs.

Restrictions on teacher control are defined in the Protection dialog box in the Student
module:

e On the Tools menu, click Options and then double-click Protection.
To prevent students from restricting teacher control, choose one of the following ways:

e Run the Student module in hidden mode. This is a startup option on each Student: On
the On the Tools menu, click Options and then double-click General. This means that
students do not have access to the Student module user interface at all except to
request assistance.

e Define a protection password and make sure that this password is not shared with the
students. On the Tools menu, click Protection Password.
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5 Creating tests

5.1 Before you create a test or survey

Before you create a test or a survey, you might want to consider whether the test or
survey and the results should be available to all teachers using Netop School or whether
they should be available to you only.

By default, tests and surveys are saved to a public folder and are visible to all teachers.
If you want to store a test and the test results so that only you can see them, switch to
the Private Tests folder before you create the test.

You can also create a folder of your own. This folder can either be private - if it is
created where only you have access, for example under your Windows user profile - or
public - if it is created for example on a file server or anywhere else on the network where
other teachers also have access.

5.2 Create a test using the Test Wizard
Creating a test using the Test Wizard consists in going through these steps:

1.In Tests View, right-click anywhere in the right pane and on the shortcut menu click
New Test.

2.Give the test a name and possibly a description to more easily identify it later on.

Once you have typed a name for the test, the Test Wizard will guide you through the
test creation and ensure that you define all the necessary options.

3. Create the test questions.
Tips

e Before you start creating questions, you might want to review the sample test that
comes with Netop School. The sample test includes examples of all question types.

e If you would rather create the test without being led through the necessary steps,
click the Advanced button to skip the wizard.

On the Test Questions wizard page, click the Add button to add a question to the
test. For details about each question type, see Question types.

Use the Scoring button to modify the default even scoring for each question. For
details about scoring and weight for each question, see Test scoring and Question
weight exceptions.

4. Define the visual layout of the test as it will be presented to the students.

5. Define test and results properties like a time limit on the test, whether the test
should start automatically on student computers, and whether you want to see test
results on an ongoing basis throughout the test.

5.3 Create a test using the Test Designer
Creating a test using the Test Designer consists in going through these steps:

1.In Tests View, right-click anywhere in the right pane and on the shortcut menu click
New Test.

31



32

Creating tests

2.

Give the test a name and possibly a description to more easily identify it later on.

Now the Test Designer opens.

.Click the Add Question button to create the test questions. For details about each

question type, see Question types.

Tips

e Before you start creating questions, you might want to review the sample test that
comes with Netop School. The sample test includes examples of all question types.

e If you would rather create the test using a wizard that leads you through the
necessary steps, click the Wizard button.

.Click the Style button to define the visual layout of the test as it will be presented

to the students.

.Click the Options button to define test and results properties like a time limit on the

test, whether the test should start automatically on student computers, and whether
you want to see test results on an ongoing basis throughout the test.

.Click the Scoring button to review and possibly change the question weights. For

details about scoring and weight for each question, see Test scoring and Question
weight exceptions.

5.4 Question types

When you create a test, whether you use the Test Wizard or the Test Designer, you can
choose between a number of different question types; some are purely text-based while
others have a mixture of text and graphics.

k=l Drop-down List

In this question type, the student reads a text where words are missing. The student
must select the correct answer for each of the missing words from a drop-down list
of true and false answers.

How to create the question type:

1.In the Text text box, write your complete text as it should appear to the
student.

2.In your text, select each word that should be part of the test and click the Select
button beneath the text box.

The selected word is shown in bold face in the text.
3.Beneath the False Answers list, click the Add button and type a false answer.

Both the words written in bold in the text, the correct answers, and the word in the
False Answers list will appear in the drop-down list that the student sees instead of
the correct words.

Tip

If the text is very long and the number of marked words and false answers becomes
too many, split the text into more questions.

See these questions in the sample test for an illustration of the drop-down list
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question type:
¢ L'imparfait - French

o Weather and climate - definitions

Essay

In this question type, the student writes an essay or any other type of free text.
How to create the question type:

e Type the question or the instructions in the Question/Instructions text box.

The student will have a basic, Notepad-like editor to write his text in.

See this question in the sample test for an illustration of the essay question type:

¢ Incomplete fairytale

Note

This is the only question type that does not offer auto-complete as a definite answer
cannot be defined for a free text question. Even with no auto-complete, a significant
advantage of this question type is that results are auto-collected and response time
potentially controlled by a time limit.

Label Image

In this question type, the student labels an image, that is, places labels in the
correct locations on a picture or other illustration.

How to create the question type:

1. Click the Add Image button the add the image file that the student will label.
2.Click the Add Label button and type a label text.

3. Move the label to the appropriate position on the image.

4. Repeat steps 2 and 3 until you have added the label texts you want and placed
them in the correct locations on the image.

The student will see a list of labels and is supposed to move each label to the
correct location.

See this question in the sample test for an illustration of the label image question
type:

¢ Name the Planets

Match Image
In this question type, the student matches images with the corresponding texts.
How to create the question type:

1.Click the Add button and select and image file.
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The image is added in the Answers list.
2.Type a text that matches the image.

The student will see the images and is supposed to move each image next to the
appropriate text.

See this question in the sample test for an illustration of the match image question
type:

e Dinosaurs

Match Text

In this question type, the student fills in blanks in a text with words from a list.
How to create the question type:

1. Type the entire text in the Text text box.

2.Select a word in the text that you want to have appear blank in the text and
click the Select button.

The text is added to the Word list list.
3. Repeat step 2 for each word that you want to have appear blank in the text.

The student will see the text as you typed it but with blanks for the words that you
selected and is supposed to place each word in the appropriate position in the text.

See this question in the sample test for an illustration of the match text question
type:

o Shakespeare - quote

Multiple Choice

In this question type, the student selects one or more answers for each question
from a list.

How to create the question type:

1.Type the question or the instructions in the Question/Instructions text box.
2.Click the Add button and type an answer.

3. Repeat step 2 for each answer you want the student to be able to choose from.
4. Select the correct answer in the list.

Optionally select the Multiple correct answers and Random order check boxes.

The student will see the question with a list of possible answers and must select one
or more. If Random order was selected, the possible answers are presented in a
different sequence for each student.

See these questions in the sample test for an illustration of the multiple choice list
question type:
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¢ The capital of France

e The Elements - science

Ordering

In this question type, the student puts items in a list in the correct sequence.
How to create the question type:

1. Type the question or the instructions in the Question/Instructions text box.
2.Click the Add button and type an item.

3. Repeat step 2 for as many items as you want the student to order.

The student will see a humbered list with no items and a list of items and is supposed
to move each item next to the appropriate humber.

See this question in the sample test for an illustration of the ordering question type:

o Days of the week

Question and Answer

In this question type, the student must type an answer to a question. The student's
answer must completely match the answer that the teacher is looking for.

How to create the question type:
1. Type the question or the instructions in the Question/Instructions text box.
2.Click the Add button and type the answer.

Depending on the question, there might be several answers. Make sure to include
all correct answers.

The student will see the question and type the answer in a basic, Notepad-like
editor. The answers have to be 100% identical to the teacher’s result list, otherwise
the answer will not be scored as correct. Note, though, there is no distinction of
case so that "A Streetcar Named Desire" is perceived as identical to "a streetcar
named desire".

Tip
If five answers are possible, you can state in the question that the student has to
list at least three.

See this question in the sample test for an illustration of the question and answer
question type:

e Tennessee Williams

Text Completion

In this question type, the student must type the missing words in a text with blanks
for some of the words.
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How to create the question type:
1.Type the entire text in the Text text box.

2.Select a word in the text that you want to have appear blank in the text and
click the Select button.

The text is added to the Word list list.
3. Repeat step 2 for each word that you want to have appear blank in the text.

The student will see the text as you typed it but with blanks for the words that you
selected and is supposed to type the missing words in the text when dictated by the
teacher.

See this question in the sample test for an illustration of the text completion question
type:

e Complete the text - dictation

5.5 Tips about creating test questions

Below are some tips that you might find useful when you are creating questions for a test.

=]

A sample test

Netop School includes a test called "SampleTest" with samples of all question types.
To view the sample questions:

1.In Tests View, double-click SampleTest.

2.In the TestDesigner, double-click the question type you want to study.

Use the Preview button to see how each of the sample questions will appear to the
student.

Preview a question

When you are creating a question you can preview the question as it will appear to
the student.

Each of the different dialog boxes to create a question includes a Preview button.

Timelimit

When you create a question, you can set a time limit on each question. When the
student has spent the allotted time on the question, the test automatically advances
to the next question.

Each of the different dialog boxes to create a question includes a Time limit button

Additional resources for a question

Some questions may require background information or illustrations. When you create
a question you can choose to attach a information to the question. The file will be
available to the student along with the question.
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Each of the different dialog boxes to create a question includes a Resources button

5.6 Tips about test settings

Below are some tips that you might find useful when you are specifying how a test should
behave during startup and while students are answering questions.

k= Allow students to skip a question and go back

You can choose to let students skip a question in a test and return to the question
later.

e Select Unrestricted in the Test Type list.

The Test Type list is available on the Test Options wizard page, and from the
Options button in the Test Designer.

k=l Specify a time limit for a test

You can choose to set an upper time limit for the test duration. When the limit is
reached the test closes automatically on the student computers.

e Type a number of minutes in the Time Limit field.

The Time Limit field is available on the Test Options wizard page, and from the
Options button in the Test Designer.

k=l Start a test automatically when all student computers are logged on

You can choose to have a test start automatically when all student computers are
logged on.

e Select the Autostart Test check box.

The Autostart Test check box is available on the Test Options wizard page, and
from the Options button in the Test Designer.

k= Prompt for student name before test start
You can choose to have students identify themselves before the test starts.
e Select the Prompt for name before test begins check box.
The Prompt for name before test begins check box is available on the Test
Options wizard page, and from the Options button in the Test Designer.

k=l  Fo